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|.PHAM VI KIEN THUC

1. LY THUYET

1.1. Pai s6:

- Toan thong ké

- Biéu thtre dai b, don thire, don thirc ddng dang

- Pa thirc, thu gon da thirc, cong, trir da thic

- Pa thirc mot bién, cong, trir da thic mot bién

- Nghiém cua da thirc

1.2. Hinh hec:

- Céc truong hop bang nhau cua hai tam giac thuong, hai tam giac vudng

- Tam gi4c can, tam giac déu, dinh ly Pitago thuan va dao

- Quan hé giira cac yéu tb trong tam giac

- Cac dudng dong quy: duong trung tuyén, duong phan giac, dudng trung truc

2. DANG BAI

- Cho bang thong ké xac dinh cac yéu té: dau hiéu, bang tan s6, mt cua dau hiéu va gia tri trung
binh.

- Thu gon va xac dinh bac ctia don thirc, da thuc.

- Cong, trir da thirc, da thare mot bién. - Tim nghiém cua da thirc.

- Tinh gia tri cua biéu thic.

- Chirng minh tam giac bang nhau, tam giac can. Van dung dinh Ii Pytago trong tam giac vudng dé
tinh d6 dai canh.

- Van dung quan hé giira céc yéu t6 trong tam gidc dé so sanh canh, goc. Van dung cac dudng dong
quy dé chizng minh thang hang, tam giac bang nhau,. ..

11.BAI TAP THAM KHAO

Bai 1. SO lugng mil chdng giot ban cua cac chi doi Trudng THCS Thanh Am trong phong trao
phong chbng dich Covid-19 dugc ghi lai nhu sau:

15 20 18 14 20 18 22 15 14 22
18 15 20 22 15 14 20 15 20 18
a) Dau hiéu diéu tra & day la gi?

b) Lap bang tan sé va tim mét cua dau hiéu

¢) Tinh s6 mil trung binh ma cac chi doi da tham gia ung ho.

Bai 2. Thu gon cac don thirc sau rdi tim hé s, bac cua don thirc d6

) TCY(-2yD) b) U)o xyE) o) (—%Xsy“j(xyz)o(—gxzysj d) —5y.(—%xy2j(§yj

Bai 3. Cho hai da thirc A =2x? —4x2y+1% xy>—y*+1 va B=-2x° —1% x2y+§xy2 -y*-3

a) Tinh gia tri cua dathuc Avéoix=1;y=-1
b) TinhA+B vaA-B



Bai 4. Cho hai da thirc f(x) =x3 - 4x2 +3x -5+ x?va g(x) =-x* —5x +3x? + 3x + 4
a) Thu gon cac da thirc f(x) va g(x).

b) Tinh h(x) = f(x) + g(x) va q(x) = f(x) — 9(x)

c) Tim nghiém cua h(x)

Bai 5. Cho hai da thirc B(x) = x® —4x® +3x+g va C(x) = 2x* + x* = 2x+ 4x* + 3x — 2x* —g

a) Tinh B(2)

b) Thu gon va sip xép da thirc C(x) theo lity thira giam dan cua bién

¢) Tim céc da thie D(x) VA E (x) biét D(x) = B(x) + C(x) ; B(X) — E(x) = C(x)

Bai 6. Tim nghiém cua cac da thac sau:

a)4x+12=0 b) (x — 1)(2x — 3) c) (X +2)(x* + 4)

Bai 7. Cho tam giac ABC vudng tai A. Buong phan giac BE. Ké EH vudng goc véi BC. Goi K 1a giao
diém cua AB va HE. Ching minh:

a) ABAE =ABHE; tir @6 chirng minh BE la duong trung truc cua AH

b) AE <EC c) BE L KC

Bai 8. Cho tam gidc ABC can tai A, BAC <90°, AC =5cm, BC =6 cm. Qua A v& tia phan giac
ctia BAC cit canh BC tai D.

a) Chung minh: AABD = AACD

b) Tinh d6 dai doan thang AD

c) Vé duong trung tuyén CF cia AABC cat canh AD tai G. Ching minh G 14 trong tim ctia AABC
d) Goi H 1a trung diém ctia canh DC. Qua H v& duong thang vudng goc v6i canh DC cét canh AC
tai E. Ching minh ba diém B, G, E thang hang

Bai 9. Hai robot ciing xuét phat tir mot vi tri A, di theo hai huéng tao véi nhau mot goc 90°. Robot 1
di vai van tdc 2 mis, robot 2 di vai van téc 1,5 m/s. Hoi sau 10 gidy hai robot cach nhau bao nhiéu
mét?

Bai 10. Ba thanh phd A, B, C cling nam trén mot

duong thang, 1 tram phat séng D cach thanh phd A > < )
50km nam trén huéng vudng goc véi dudng thang l
nay, khoang céach tir tram phéat séng dén hai thanh e
phd B va C labang nhau. Hoi thanh phé A, B,Cc6
nhan dugc song khong? Biét khoang cach nhan | & | T ] T
song trong pham vi 100km va khoang cachgitahai . .
thanh phé B va C 1a 240km
BGH TO CHUYEN MON NHOM CHUYEN MON

Duyét Duyét

L& Thi Ngoc Anh Nguyén Thé Manh Ngd Qudc Chién






PHONG GD&DT QUAN LONG BIEN
TRUONG THCS THANH AM

Nim hoc 2021- 2022
A. HE THONG BAI HOC:
I. VAN BAN:

1. Noi dung:

NQI DUNG ON TAP CUOI HQC K1 11
Mon: NGU VAN 7

- Van ban nghi luan ching minh: Buc tinh gian di caa Bac HO, Y nghia vian chuong.

- Truyén ngan hién dai: Song chét méc bay.

- But ki: Ca Hué trén s6ng Huong.

2. Yéu cau

- Lap bang thong ké theo mau

TT

Téac pham | Tacgia | Thé
loai

Ph}l’O’Hg
bieu dat

thirc

No¢i dung, y nghia

Nghé thuat dac
sac

- Ghi nhé ndi dung chinh ctia cac van ban.

- Traloi cac cau hoi cubi bai.
I. TIENG VIET:

1. Noi dung

- Cac phép bién doi cau:

+ Rut gon cau: cau rat gon, cau dac biét.
+ Mo rong cau: thém trang ngir cho cau, dung cum chu - vi d€ mo rong cau.
+ Chuyén doéi kiéu cau: chuyén doi cau chu dong thanh cau bi dong.

- Phép tu tu: liét ke.

- Céc loai d4u cau: dau chdm lung, ddu cham phay, dau gach ngang.

2. Yéu cau

- Khai niém, phan loai, cach st dung, tac dung cua cac don vi kién thirc.
Van dung kién thire Tiéng Viét d3 hoc vao 1am bai tap.

I11. TAP LAM VAN
1. Noi dung: vin nghi luan
2. Yéu cau:

- Ghi nhé khai niém, dac diém va phuong phap lam cac ki€u van nghi luan.

- Thuc hién céc budc Iam bai cho mdt s6 d€ van nghi luan cu thé.

B. MOT SO DANG BAI CU THE

Dang 1: Chuyén céc cau chi dong sau thanh cau bi dong:

a. Ngoai cho, nhitng ngudi ban hang rong da bay ban tao xanh dau mua.
b. T6i vira lam xong dé cuong 6n tap mon Ngir Vin.
c. Nhac si sang tac ban nhac dat dao cam x(c ay chi trong thoi gian ngan.
d. Cac kién tric sw xdy ngdi nha nay trong 7 nam.
Dang 2: Tim va néu tac dung cau dac biét, cau rat gon trong cac cau sau:

a. An qua nhé ké trong cay.

b. Anh oi! Bao gi 40 anh c6 rach, anh tim vé chd em, em vé cho anh nhé.
c. Me¢ khong lo nhung van khong ngu dugc. Cir nham mat lai 1a duong nhu vang bén tai

tiéng doc bai tram bong [...]

d. Pinh chién. Céc anh bo d6i non luéi gan sao kéo vé day nha Ut...
Dang 3: Tim cum C-V lam thanh phan cau hoac thanh phan cum tir trong cac cau sau
va cho biét nhitng cum C — V d6 lam thanh phan gi?

a. Cudc doi day song gio6 khién chi dy truong thanh hon.

b. Con gai Hué noi tam that phong phi va am tham, kin dao, sdu tham.




c. Biic tranh treo trén tudng di bi mot dn gan hét.
d. Troi mua to lam cay cdi nga nghiéng.
Dang 4: Tim, phan loai va néu tac dung cua phép liét ké duoc sir dung trong cac cau
sau:
a. Chang ta c6 quyén tu hao vi nhitng trang lich sir vé vang thoi dai Ba Trung, Ba
Triéu,Tran Hung Pao, L& Loi, Quang Trung...
b. Bén canh ngai, me tay trai, bat yén hip dudng phén dé trong khay kham, khoi bay
nghi ngUt, trap chir nhat ddi moi dé mo, trong ngan bac day nhitng triu vang, cau dau,
ré tia, hai bén nao ddng hd vang, nao dao chudi nga, nao éng voi cham, ngoay tai, vi
thudc, quan but, tim bong trong ma thich mat.
c. Con géi Hué noi tam that Pphong pht va am tham, kin d4o va sau tham.
Dang 5: Dt cau theo yéu cau cu thé: dat cau co sir dung trang ngit, ¢ st dung cac loai
diu cau, cac phép liét ke.
Dang 6: Bai tap tong hop:
Bai 1: Poc ngir liéu sau va tra loi cac cau héi ¢ dudi.
“...Quan Ién vé tay xuong sdap kéu to:

- Pdy roil... Thé chit lai!
Réi ngai véi vang xoe bai, miéng vira curoi vira noi:
- U! Thong tom chi chi nay!... Biéu may!...
Ay trong khi quan 6n @ van bai to nhur thé, thi khap moi noi mién dé, meéc tran 1énh
lang, xoay thanh viec sau, nha cita tréi bang, hia md ngdp hét; ké song khdng ché ¢, ké
chét khong noi choén, lénh dénh mat nuoc, chiéc bong bo vo, tinh canh tham sau, ké sao
cho xiét!”

(Ngtr van 7 tap 2, trang
74)
Cau 1: Boan trich trén duoc trich tir van ban nao? Tac gia la ai?
Cau 2: Poan trich trén sir dung phuong thuc biéu dat nao?
Cau 3: Chi ra nét nghé thuat tiéu biéu nhat c6 trong doan trich néu tac dung cua bién
phap nghé thuat do.
Cau 4: Hay viét mot doan van ngin khoang 8- 10 cau dé giai thich ¥ nghia nhan dé cua
truyén ngan “Song chét mic bay” caa Pham Duy Tén.
Bai 2: Poc doan vin sau va tra loi cau hoi:

"Van chwong gay cho ta nhizng tinh cam ta khéng co, luyén nhing tinh cam
ta sdn co; cude doi phi phiém va chat hep ciia cd nhén vi vin chwong ma tré nén
tham tram va réng rdi dén tram nghin lan.

CO ké noi tur khi cdc thi st ca tung canh ndi non, hoa cg, ndi non, hoa co trong
M&i dep; tir khi ¢6 nguoi ldy tiéng chim kéu, tiéng suéi chay lam dé ngam vinh, tiéng
chim, tiéng sudi nghe méi hay. Loi dy tuwéng khéng c6 gi la qud ding."

(Ngtr van 7, tap 2, trang

61)

Cau 1: Cau van trén dugc trich trong van ban nao? Cua ai?
Cau 2: Néu phuong thirc biéu dat chinh cua vin ban?
Cau 3: Trong cau van dugc tac gia da s dung nhirng bién phap nghé thuat gi? T do
tac gia khang dinh tac dung cua van chuong nhu thé nao?
CAu 4: Xac dinh 01 cAu md rong thanh phan trong doan vin va cho biét cAu vin 4y duoc
mé rong thanh phan nao?
Cau 5: Hay viét mot doan vin ngan tir 8 — 10 cau dé chirng minh rang “véin chwong gay
cho ta nhieng tinh cdm ta khong co”.



Bai 3: Poc doan trich sau va tra loi cac cau hei:

“Dém. Thanh phé 1én dén nhir sao sa. Man swong day dan 1én, canh vdt mo di
trong mét mau trang duc. Téi nhw mét lir khach giang hé véi hon tho lai ldng va tinh
nguoi nong hdu budc xuong mgt con thuyén rang, c6 1é con thuyén ndy xua kia chi danh
cho vua chiua. Trudéc miii thuyen la mét khéng gian réng thodng dé vua héng mat ngam
trang, gira la mgt san go bao nhan ¢é mui vom dugt trang tri long ldy, xung quanh
thuyen co hinh rong va triede miii la mét dau rong nhwe muon bay 1én. Trong khoang
thuyén, dan nhac gém dan tranh, dan nguyét, ti ba, nhi, dan tam. Ngoai ra con c6
dan bau, sdo va cdp sanh dé go nhip.

(Ngtr van 7, tap 2, trang 100)
Cau 1: Doan trich trén dugc trich trong van ban nao? Tac gia la ai?
CAu 2: Vin ban chua doan trich trén thudc thé loai gi? Ké tén 01 van ban em di duoc
hoc trong chuong trinh Ngit Van THCS ¢6 cung thé loai véi van ban chira doan trich
trén.
Cau 3:
a) Cau van “Pém.” Thudc kiéu cau gi? Néu tac dung cua viéc sir dung kiéu cau do trong
doan van.
b) Tim cau rut gon co6 trong doan van trén.
Cau 4: Chi rd va néu tac dung cua bién phap tu tir dugc stir dung trong cau van in dam
cua doan trich.
Cau 5: Cho cau chu dé: “Ca Hué 1a mét hinh thic sinh hoat vin héa déc ddo”, dua vao
nhitng hiéu biét cia em vé vian ban chira doan trich, hay viét 01 doan van ngan tir 8-10
cau 1am séang to cau chu dé trén. Trong doan vin c6 sir dung mot dau cham lang. Néu
rd cong dung cua dau chim ling do.
Dang 8: Viét bai tap lam van
Pé 1: Hay giai thich y nghia cau tuc ngir: “Thdt bai 1a me thanh céng ”.
Pé 2: Hay chang minh, giai thich ngudi xwa mudn nhan nha diéu gi qua cau ca dao:
“Nhiéu diéu phi ldy gid guong
Nguoi trong mot nueoc phdi thuwong nhau cung.”
Pé 3: Giai thich, chitng minh 1am séng to cau tuc ngi:
“Mgt cay lam chang nén non
Ba cay chum lgi nén hon nli cao”



PHONG GD & PT QUAN LONG BIEN PE CUONG ON TAP CUOI HOC KY I
TRUONG THCS THANH AM MON: TIENG ANH- LOP 7
NAM HOQC: 2021- 2022

A. SPEAKING
CODE 1
I. Introduction (5pts)
-Introduce yourself ( names / age / hobbies....)
Il. Topic ( 15pts)
TRAFFIC
1.What should you do to have traffic safety?
2.When you are a road user, what should you NOT do?
3.Should one drive after drinking alcohol? Why or why not?
4.How do you go to school every day? And how far is it from your house to school?
CODE 2
I. Introduction (5pts)
-Introduce yourself ( names / age / hobbies....)
Il. Topic ( 15pts)
FILMS
1. What kind of films do you like best?
2. How often do you watch films?
3. Do you prefer to watch films in the cinema or at home?
4.Can you talk about your favourite film?
CODE 3
I. Introduction (5pts)
-Introduce yourself ( names / age / hobbies....)
Il. Topic ( 15pts)
FESTIVALS
Talk about the festival you know
1.What is the name of the festival?
2. When and where is it held?
3. What do they often do during the festival?
5. What’s special about it?
CODE 4
I. Introduction (5pts)
-Introduce yourself ( names / age / hobbies....)
Il. Topic ( 15pts)
SOURCES OF ENERGY
1.What are some main sources of energy in Vietnam?
2. Name some renewable sources of energy and non-renewable sources of energy.
3. How is your carbon footprint?
4. What do you do to save energy?
CODE5
I. Introduction (5pts)
-Introduce yourself ( names / age / hobbies....)
Il. Topic ( 15pts)



TRAVELLING IN THE FUTURE
1. What means of transport will people travel in the future?

2.What is your favourite means of transport in the future? Why? How will it travel?

3.How will people avoid traffic jam in the future?
B. VOCABULARY AND GRAMMAR
I. Vocabulary:
From unit 7 to unit 12
1. Grammar:
1. Vocabulary: Unit 7-Unit 12

Sounds: /e/ and /ei/, t/, /d/, /id/
It indicating distance

Used to

-ed and —ing adjectives

H/Wh-questions

Adverbial phrases

. Word stress (two and three syllables)
10 The future continuous tense

11.The future simple passive
12.Possessive pronouns

13.Tag questions

14.Comparisons of quantifiers

15.Tag questions

©ooNeOGThAEWDD

Connectors: although, despite/in spite of, however, nevertheless

. many
. dead

. expensive
. afraid

. reverse

. liked

. amazed

. missed

. watched

. engaged

. record

. result

. suspect

. interview
. poverty

. recognize
. abundant

C. EXERCISES

I. Find the word which has a different sound in the part underlined.
1. A. station B. mistake C. lane D
2. A. ready B. break C. ahead D
3. A. pretty B. depend C. left D
4. A. straight B. pain C. said D
5. A. recycle B. vehicle C. helicopter D
6. A. wished B. gripped C. loved D
7. A. excited B. enjoyed C. bored D
8. A. laughed B. ended C. shocked D
9. A. advertised B. murdered C. performed D
10. A. produced B. terrified C. entertained D
I1. Circle the word with a different stress pattern from the others.
1 A. project B. picture C. answer D
2 A. progress B. increase C. permit D
3 A.open B. transfer C. refund D
4 A. pregnancy B. deliver C. restaurant D
5 A. solution B. physician C. confusion D
6 A. dedicate B. terrify C. recommend D
7 A. littering B. serious C. spacious D
8 A. polite B. funny C. lovely D

. busy



9 A. describe B. enter C. agree D. replace

10 A. station B. student C. disease D. winter

I11. Choose the best option to complete each sentence.

1. My friend has a 3-year-old brother. The boy in this picture is younger
brother.

A. her B. hers C. she D. she’s

2. Is described as a solar-powered car with 2 wings.

A. Its B. It C. It's. D. Itis

3. bus is here, will come in 5 minutes.

A. Mine/ yours B. Mine/ your C. My/ yours D. My/ your

4. The ideas of the future plane are all ?

A. ours B. our C.us D. we are

5. There will be places for children to play.

A. more B. less C. much D. None of them
6. Children in poor areas have time to study.

A. many B. fewer C. less D. Both Aand B
7. Hanoi has skyscrapers than any other cities in the North of Vietnam.
A. less B. more C. many D. Both Aand C
8. Nowadays, there are local people join in community tourism activities.
A. less B. more C. much D. BothBand C
9. The countryside has shopping centers than a big city.

A. many B. few C. fewer D. much

10. In India, the demand for has always been more than the supply.
A. shortage B. sources C. slogan D. electricity

11. energy is produced by collecting sunlight and converting it into
electricity.

A. Hydro B. Nuclear C. Solar D. Wind

12. There are many available power sources in Vietnam including sun,
wind, water, etc.

A. nuclear B. hydro C. renewable D. solar

13. Thatwas a and boring horror film so | slept from the beginning to the
end.

A. shocking B. entertaining C. gripping D. predictable
14. 1 didn't expect the movie to be so interesting and so I'l cried at the end
of the film.

A. moving B. violent C. confusing D. hilarious

15. According to our latest survey, Batman is one of 10 films this
summer.

A. must-see B. violence C. embarrassed D. stunt

16. Woody Allen is one of some directors who in their own films and
receive positive reviews.

A. set B. star C. recommend D. make

17. The film had such a sudden and ending that no one can imagine.

A. disappointed B. must-see C. predictable D. shocking

18. Watching films may make people more aggressive.

A. hilarious B. violent C. entertaining D. gripping



19. is part of the Thai New Year. People throw buckets of water on
each other to wish for luck.

A. Mid-autumn festival B. Easter C. Thanksgiving  D. Water
Festival

20.What | like about festivals is that they show the values of different
communities.

A. Carnival B. culture C. cultural D. parade

21. Non-renewable energy comes from sources that will eventually

A. run way B. run down C. run over D. run out

22. energy doesn’t cause pollution.

A. Social B. Solar C. Sociable D. Sunny
23.Gas and oll always increases in cold weather.

A. consumers B. consume C. consumption D. consumable
24. Wind is a source of energy.

A. renewable B. non-renewable  C. renewed D. renewing

Choose the word or phrase that is CLOSEST in meaning to the underlined part
in each of the following sentences.
25. A video game will provide endless hours of fun.

A. irregular B. short C. deep D. limitless
26. The city is facing serious pollution problems.
A. hard B. minor C. false D. light

Choose the word or phrase that is OPPOSITE in meaning to the underlined
part in each of the following sentences.
27. The Segway is becoming more popular these days.

A. attractive B. suitable C. likeable D. uncommon
28. Red minibuses often provide more convenient transport for rides.
A. suitable B. unpleasant C. good D. available

IVV. Choose the underlined part that needs correcting in ach sentence below.
1. Not many people went to see the film; because of good reviews from critics.

A B C D
2. The boy was so frightening by the film that he couldn’t go to sleep last night.
A B C D
3. “The last words” was so bored that we all fell asleep at the middle of the film.
A B C D

4. We find “Avenger” really excited.

A B C D
5. Last night, | didn’t go to bed early although being very tired.

A B C D

6. The horses will be take to the stable.

A B C D
7. The door will have be painted sooner or later.

A B C D
8. The new building will be show to the tourist.

A B C D

V. Read the passage and choose the correct answer to complete the passage.
Ewan McGregor



Ewan McGregor was born in Scotland in 1971. He decided to be an actor when he

was only nine and he (1) his first film in 1992. So far in his career he has
(2) in a lot of different types of films, including comedies, musicals, dramas
and the Star Wars movies. His uncle, Denis Lawson, was in the original Star War in
1977 and McGregor (3) in his first Star Wars movie 22 years later. In his
career Ewan McGregor has worked with actresses like Cameron Diaz and Nicole
Kidman, and his films have won lots of (4) . He loves acting and when he
finished (5) the musical, Moulin Rouge, he said, 'l have never been happier
to do anything in my life.'

1.A.made B.played C.worked D.starred

2.A.attended B.appeared C.joined D.participated
3.A.acted B.performed C.starred D.took
4.A.profit B.money C.presents D.awards

5.A.filming B.film C.to film D.filmed

V1.Read the passage and choose the correct answer for each question.

In Britain, the climate is not very good. There are very few hot days and it rains a lot.

Because of this, people spend a lot of time at home. Generally, British homes have a

lot of furniture in them, carpets on the floors and heavy curtains.

Many houses in Britain are old. Many of them are over one hundred years old. Often,

they do not have enough insulation and the heat goes out through the windows, the

doors and up the chimney.

Because of the climate, people in Britain have to spend a lot of money on heating.

Many houses have a special system called "central heating". This heats all the rooms

and, at the same time, heats the hot water. Houses without central heating often have

gas, electric or coal fires. The rooms in most British houses are quite small.

New houses are much better. They have two layers of glass in the windows to stop
the heat going out.

1.Why do British people spend a lot of time at home?

A.Because the climate is not very good. B.Because they don’t know where to
go.

C.Because the climate is very good. D.Because they want to stay at home.

2.The heat goes out of the houses through :

A.the doors and up the chimney B.the windows and up the chimney

C.the windows, the doors and up the chimney D.the walls and up the chimney

3.Because of , people in Britain have to spend a lot of money on
heating.

A.cold weather B.cool weather C.hot weather D.bad
weather

4.Houses without central heating often have

A.only coal fires B.gas or coal fires

C.electric or coal fires  D.gas, electric or coal fires

5.New houses usually have in the windows to stop the heat going out.

A.one layer of glass B.two layers of glass

C.three layers of glass ~ D.two or three layers of glass
VI11.Choose the sentence (A, B, C or D) that is closest in meaning to the root
sentence.



1. How will people learn languages in the future?

A. How are languages learned in the future?

B. How do languages learn in the future?

C. How are languages learn in the future

D. How will languages be learned in the future?

2. They will cancel all flights because of the bad weather.

A. All flights will cancel because of the bad weather.

B. All flights have canceled because of the bad weather.

C. All flights will be canceled because of the bad weather.

D. All flights have been canceled because of the bad weather.

3. People will not use that old building from now on.

A. That old building will not being used from now on.

B. That old building will not been used from now on.

C. That old building will not be used from now on.

D. That old building will be used from now on.

4. January has 31 days. February has 28 days .

A. January has fewer days than February.

B. January has more days than February.

C. February has the same days as January.

D. February has more days than January.

5. Do you like reading books?

A.You like reading book, don’t you?

B.You like reading book, aren’t you?

C.You like reading book, do you?

D. You like reading book, didn’t you?

6. | /find /English / interesting.

A. | am interested on English

B. I am interesting in English

C. I am interested in English

D. I am interested at English.

7. Although / she / hungry / not eat / anything / yesterday.

A. Although she is hungry, she didn’t eat anything yesterday.

B. Although she was hungry, she doesn’t eat anything yesterday.
C. Although she has been hungry, she hasn’t eaten anything yesterday.
D. Although she was hungry, she didn’t eat anything yesterday.
VII1.Rewrite the sentences, using the words in the brackets.
1.The new restaurant looks good. It seems to have few customers. (however)
2.We planned to visit Petronas in the afternoon. We could not afford the fee.
(however)

5.1 couldn’t sleep. I was tired. (in spite of)



IX. Rewrite the following sentences in passive voice.
1.Students will use public transport to go to school.

X. Add tag questions to the following sentences.

1.Everyone can learn how to swim, ?

2.Nobody cheated in the exam, ?

3.Nothing went wrong while | was gone, ?

4.1 am invited, ?

5.This bridge is not very safe, ?

6.He has a bicycle, ?

7.Peter would like to come with us to the party, ?
8.Those aren’t Fred’s books, ?

9.You have never been to Paris, ?

10.Something is wrong with Jane today, ?

XI1.Make questions for the underlined words in the following sentences.
1.People eat traditional foods in this festival.

2.Children are very happy because they receive a lot of lucky money from their
relatives.




TRUONG THCS THANH AM NOI DUNG ON TAP CUOI HOC KI I
Nim hoc: 2021- 2022 MON: PIA LI 7

A.NOI DUNG ON TAP

1. Hoc sinh 6n tap kién thuc cac bai: 51,52,54,44,56,67,58,59.
2. Noi dung chinh:

* Phan 1: Khai quat chung vé khu viec chau Au.

- Thién nhién chau Au.

- Dan cu, x& hoi chau Au.

- Kinh té chau Au.

* Phan 2: CAc khu vuc chau Au.

- Khu vuc Bic Au.

- Khu vuc Bong Au.

- Khu vuc Tay va Trung Au.

- Khu vgc Nam Au.

B. CAU TRUC PE THI

- 50% trac nghiém.

- 50% tu luan.

C. HE THONG CAU HOI ON TAP

Cau 1: Trinh bay dic diém vi tri dia 1i va dia hinh chau Au.
CAu 2: Trinh bay dic diém nganh cong nghiép va dich vu ¢ chau Au.
CAu 3: Trinh bay dic diém ty nhién khu vuc Tay va Trung Au.
CAu 4: Trinh bay dac diém kinh té khu vuc Nam Au.

Cau 5: Quan sat buc tranh sau:




TRUONG THCS THANH AM
Nam hoc 2019- 2020
NOI DUNG ON TAP HOQC Ki II MON GDCD LOP 7
A/ HE THONG BAI HQC
1. Quyén dugc bao v€, cham séc, gido duc cua tré em Viét Nam.
2. Bao vé moi trudong va tai nguyén thién nhién.
3. Bao vé di san van hoa
4. Quyén tu do tin ngudng va ton gido
5. Nha nudc Cong hoa xa hdi chu nghia Viét Nam.
B/ BAI TAP:
1/Bai tap sau mdi bai hoc trong sach gido khoa.
2/Tao duge tinh hudng, giai quyét duge mot sé tinh hudng c6 lién quan dén timg chu
de.
3/Tim va giai thich duoc mot sd tuc ngir, thanh ngit, ca dao, danh ngdn,...lién quan dén
tirng chu dé.
4/Lién h¢ ban than ...
C.MOQT SO CAU HOI CU THE
Cau 1: Hay néu cac quyén va bon phan cua tré em Viét Nam?
CAu 2: Thé nao 1a di san vin hoa? Néu nhiing quy dinh ciia Phap luat vé bao vé di san
vin héa? Ban than em d c6 nhimg hanh dong nao gdp phan bao vé di san vin hoa?
CAu 3: Thé nao 1a tin ngudng, ton gido, mé tin di doan? Quyén tu do tin ngudng ton
giao la gi?
Cau 4: Vi sao no6i nha nudc Cong hoa xa hoi chu nghia Viét Nam la nha nude cua dan,
do dan va vi ddn? Cong dan c6 quyén va trach nhiém gi véi dai biéu minh bau ra?
Ciau 5: Bai tip tinh hudng
Tinh huéng 1: Thuong va Huyén dao choi trong cong vién. Nhai xong keo cao su,
Huyén tién tay virt xudng ngay canh 16i di. Thay vay, Thuong nhac ban nhat Ién bo
vao thung rac. Huyén biu mdi cuoi: “Cau lam gi ma nghiém trong thé, mot mau keo
cao su thi c6 dang vao dau. Hon nita, ddu chi minh té lam vay, cling ¢6 nhiéu ngudi
vt rac bura bai do thoi.”
a) Em c6 nhan xét gi vé hanh vi va ¥ kién ctia Huyén?
b) Néu em 1a Thuong, em s& ndi gi véi ban dé ban hiéu dugc tAm quan trong cta
viéc bao v€ mdi trudng tur nhitng viéc nho nhat?
Tinh hudng 2: Gan nha H c6 gia dinh 6ng T chuyén budn ban dong vat hoang di va
quy hiém. Ca bd me H va hang xém xung quanh déu biét. P4 may lan H dinh bao cho
chinh quyén dia phuong vé hanh vi sai trai ndy nhung bé me H khong cho véi li do d6
khong phai 13 trach nhiém ctia H va dé tranh gy phién toai dén gia dinh.
a) Theo em, cach suy nghi va xir sy cia bd me H trong truong hop nay co ding
khéng? Vi sao?
b) Néu em 14 H trong truong hop ndy, em s& lam gi?



TRUONG THCS THANH AM PE CUONG ON TAP HQC Ki

Nim hoc 2021 - 2022 MON LICHSU 7

I. NOI DUNG ON TAP:
- Bai 22: Sy suy yéu cua nha nuéc phong kién tap quyén.
- Bai 23: Kinh té, van hoa thé ki XVI-XVIII.

- Bai 24: Khoi nghia ndong dan Pang Ngoai.
- Bai 25: Phong trao Tay Son.

1. CAU TRUC PE THI

- Tric nghiém: 50%
- Ty luan: 50%
I1l. HE THONG CAU HOI ON TAP

Cau 1: Em hay néu hau qua caa cudc chién tranh Nam-Bac triéu va su chia cat Pang
Trong — Dang Ngoai thé ki XVI-XVII.
CAu 2: Lap nién biéu vé hoat dong cuia phong trao Ty Son tir nim 1771 dén 1789.
Cau 3: Trinh bay nguyén nhan thing loi va y nghia lich si cia phong trao Tay Son?
Cau 4:
a. Trinh bay dic diém ton gido nudc ta thé ki XVI— XVIII.
b. Chir qubc ngit ra doi trong hoan canh nao?
Cau 5: Ngay 5 thang 1 am lich hang nim & Ha Noi dién ra 18 hoi nao? Trinh bay hiéu
biét ctia em Vvé 18 hoi d6?



PHONG GD & PT QUAN LONGBIEN ~ HUGNG DAN ON TAP CUOI HQC K1 I
TRUONG THCS THANH AM MON: CONG NGHE 7
Niim hoc 2021 — 2022

1. PHAM VI KIEM TRA

1. LY THUYET
- Vai tro va nhiém vu phat trién chan nuoi
- Gibng vat nudi
- Su sinh trdng va phat duc cua vat nu6i
- Mot sé phuong phap chon loc va quan Iy gibng vat nudi
- Nhan gibng vat nudi
- Thite an, vai tro, ché bién, dy trit va san xuét cua thirc vat nudi
2. DANG BAI
- Cau hoi tu luan:
+ Néu cac dinh nghia da hoc.
+ LAy vi du cho cac ndi dung
- Cau hoi trac nghiém.
Il.  CAU HOI MINH HOA
A. Mgt s6 cau héi tu luan:
Cau 1: Thirc an dugc co thé vat nudi tiéu hoa nhu thé ndo? Vai tro cia thire an ddi voi
co thé vat nuéi.
CAu 2: Chan nudi ¢o vai trd gi trong nén kinh té cia nuéc ta
CAu 3: Néu céac cach phan loai gidng vat nuéi? Vi dy?

CAu 4: Hay cho biét nhiém vu phat trién cta chin nudi ¢ nudc ta trong thoi gian t6i?

B. Mot s6 cau héi trac nghiém:
Cau 1: San xuat vac-xin thuong hay dugc thir nghiém trén con vat nao?

A. Lon. B. Chuét. C. Tinh tinh. D. Ga.
Céu 2: Con vat nu6i nao dudi day la gia suc?

A. Vit. B. Ga. C. Lon. D. Ngan.
Cau 3: Gidng bo vang Nghé An la giéng duoc phan loai theo hinh thirc:

A. Theo dia ly. B. Theo hinh théi, ngoai hinh.

C. Theo mirc &6 hoan thién caa giéng. D. Theo hudng san Xuat.

Cau 4: Gidng Lon Lan do rat thudc giéng lon theo hudng san xuat nao?

A. Gidng kiém dung. B. Giong lon huéng mé.

C. Gidng lon huéng nac. D. Tht ca déu sai.

Cau 5: Trang thy tinh dé tao thanh:

A. Giao tir. B. Hop tr. C. Cathé con. D. Ca thé gia.
Cau 6: Budng trang cua con ci lon 18n cung véi su phét trién caa co thé, qua trinh do
duoc goi la:

A. Su sinh truong. B. Su phét duc.

C. Phét dyc sau d6 sinh truong. D. Sinh trudng sau d6 phat duc.
CAu 7: Ga mai bat dau dé trimg, qua trinh d6 duoc goi la:

A. Su sinh truong. B. Su phét duc.

C. Phét duc sau d6 sinh truéng. D. Sinh truong sau d6 phat duc.

Cau 8: Chon gidng vat nudi 1
A. Can cur vao muc dich chan nudi dé chon nhitng vat nudi dyc lai lam giong.


https://vietjack.com/giai-bai-tap-cong-nghe-7/trac-nghiem-vai-tro-va-nhiem-vu-phat-trien-chan-nuoi.jsp
https://vietjack.com/giai-bai-tap-cong-nghe-7/trac-nghiem-giong-vat-nuoi.jsp
https://vietjack.com/giai-bai-tap-cong-nghe-7/trac-nghiem-su-sinh-truong-va-phat-duc-cua-vat-nuoi.jsp
https://vietjack.com/giai-bai-tap-cong-nghe-7/trac-nghiem-mot-so-phuong-phap-chon-loc-va-quan-ly-giong-vat-nuoi.jsp
https://vietjack.com/giai-bai-tap-cong-nghe-7/trac-nghiem-nhan-giong-vat-nuoi.jsp
https://vietjack.com/giai-bai-tap-cong-nghe-7/trac-nghiem-thuc-an-vat-nuoi.jsp

B. Cin ctr vao muc dich chin nuéi dé chon nhitng vat nudi cai lai lam giéng.

C. Cin ctr vao muc dich chin nudi dé chon nhitng vat nudi duc va céi lai 1am giéng.

D. Cén ctr vao myc dich chan nu6i dé chon nhiing vét nudi con bé lai lam giong.
Céau 9: De chon loc giéng ga Ri hgay cang t6t hon, ngudi ta gitr lai 1am gidng nhirng
con ga trong va mai khong c6 dic diém nao duéi day?

A. Chong 16n. B. C6 tinh 4p bong.
C. B¢ nhiéu trang. D. Nudi con khéo.
CAu 10: Phuong phéap nao dudi day 1a nhan giéng thuan chung:
A. Ga Lo go x GaRi. B. Lon Mong Céi x Lon Lan do rat.
C. Lon Mong Cai x Lon Ba Xuyén. D. Lon Méng Cai x Lon Mdng Cai.
Céau 11: Rom lta la loai thirc an cho vat nu6i nao dudi day?
A. Trau. B. Lon. C. Ga. D. Vit.
Cau 12: Trong cac loai thtrc dn sau, loai ndo ¢ ngudn gbc chat khoang?
A. Cam. B. Khd dau dau twong.
C. Premic vitamin. D. Bot ca.
Cau 13: Da day cua mot s6 vat nudi an co nhu trau, bo, dé, ctru... c6 may ti?
A. 3. B. 4. C.5. D. 6.

CAu 14: Nudéc trong thire an sau khi qua duong tiéu hda cia vat nudi chuyén thanh chat
dinh dudng nao dudi diy ma co thé c6 thé hap thu?

A. Nuéc. B. Axit amin. C. buong don. D. lon khoéang.
Cau 15: Trong cé4c chat dinh dudng sau, chat nao dugc co thé hap thy truc tiép khong
can qua budc chuyén héa?

A. Protein. B. Mubi khoang.  C. Gluxit. D. Vitamin.

CAu 16: Trong cac phuong phap ché bién thirc an sau, phwong phap nao 1a phuong phap
vat 1i?

A. U men. B. Kiém héa rom ra.
C. Rang dau. D. buong hoda tinh bot.
Cau 17: Vi cac thice an hat, nguoi ta thuong hay sir dung phuong phép ché bién nao?
A. Nghién nho. B. Cat ngan C. U men. D. buong hda.
CAu 18: Thanh phan dinh dudng chi yéu cia Rom lda la:
A. Chit xo. B. Protein. C. Gluxit. D. Lipid.

Cau 19: Hat ngd (bip) vang co chtra 8,9% protein va 69% gluxit. Vay hat ngd thudc
loai thirc an gidu thanh phan dinh dudng nao?

A. Chit xo. B. Protein. C. Gluxit. D. Lipid.
Cau 20: Tan dyng dat vuon, ring, bo muong dé trong nhiéu loai co, rau xanh cho vat
nudi thugc phuong phéap san xuat thie an giau chat dinh dudng gi?

A. Chét xo. B. Lipid. C. Gluxit. D. Protein.



PHONG GD — BT QUAN LONG BIEN NQI DUNG ON TAP HQC K1 II
TRUONG THCS THANH AM MON SINH HQC 7
Nim hoc 2021 — 2022 ]

I. Pham vi 6n tap:
1. Ly thuyét:
+ Chirong 6: Nganh Péng Vit c¢é xwong song.
+ Chuwong 7: Sw tién hoa ciia déng vat.
+ Chuwong 8: Béng Vit va doi song con nguroi
2. Dang bai
- Cau hoi tu luan: nhan biét, so sanh - phan biét 1 s6 khai niém va lién hé thuc té.
- Cau hoi tric nghiém
II. Ciau héi minh hoa
A. Mot s6 cAu héi tw ludn
Cau 1: Thé nao la dong vat quy hiém? Trinh bay cac muc do phan loai dong vat
quy hiém va néu vi du minh hoa.
CAu 2: Thé nao I bién phap dau tranh sinh hoc? Ké tén, néu vu diém va han ché
cuia cac bién phap dau tranh sinh hoc.
Cau 3: So sanh dic diém sinh san cia tho hoang va than lan bong, tir d6 em co
nhan xet gi?
Cau 4: O ddng vat c6 may hinh thirc sinh san? Hay so sanh cac hinh thuc sinh
san do, tir d6 em c6 nhan xét gi?
Cau 5: Vi sao chim la dong vat hang nhiét, nhung vao mua dong, mot s6 loai chim
& phuong Bic van di cu vé phuong Nam
B. Mot s6 cAu héi tric nghiém

Céu 1. Pic diém nao sau day la caa l6p Tha?

A. C6 bo 16ng mao bao phu co thé, ring phan héa thanh 3 loai.

B. Minh c6 16ng vil bao phil, chi trudc bién d6i thanh canh da.

C. La dong vat bién nhiét, c6 hién tuong tri dong.

D. Pé con va nudi con bang sita me.
Cau 2. Dé con dwoc xem la hinh thirc sinh san hoan chinh hon so véi dé tring
Vi

A. phoi duoc phét trién trong co thé cua bd nén an toan hon.
B. X4c suat triing gap duoc tinh tring 1a thap hon.
C. phdi dugc phat trién ngoai co thé me nén an toan hon.
D. phéi dugc phét trién trong co thé me nén an toan hon.
Cau 3. Pic diém giup dong vat thich nghi véi méi treong hoang mac déi
nong la
A. mau 18ng tring, c6 buéu md, chan ngan.
B. mau I6ng nhat, c6 buéu ma, chan dai.
C. mau 16ng sam, 16p md dudi da day, chan dai.
D. mau I6ng nhat, 16p m& duai da day, chéan dai.
CAu 4. Sap xép cac Lop dong vat sau theo chiéu hwéng tién hoa.
(1) Lép Ludng cu; (2) Lép Chim; (3) Lop Tha; (4) Lop Bo sét; (5) Lop cé sun.
ABS)—-@—-(1)—2)— (1) B.%5—-{0)—% —2)—(3).



COo-1H-@—-2)—@03). D.5)—=()— @) —@3)— ).
Cau 5. O ddng vat, sinh san vd tinh gém c6 2 hinh thic 14
A. tiép hop va phan doi co thé. B. moc chdi va ghép chdi.
C. phén ddi co thé va moc choi. D. moc chdi va tiép hop.
Céu 6. Trén trai dit, vi khuan va vi khuan lam xuét hién cach day khoang
A. 5000 triécu nam. B. 600 triéu nam. C. 4600 triéku nam. D.
3000 triéu nam.
Céu 7. Loai dong vat nao dwéi diy song trén mit dat?

A. Nhim. B. Chudt ddng. C. Dui. D. Ngua
van.
Ciu 8. Loai dong vat c6 quan hé ho hang gan véi tdm sdng nhat Ia

A. nhén do. B. ca chép. C. than lan béng. D. trai
song.

Cau 9. Nguyén nhan nao dwéi day khong gy ra sw suy giam da dang sinh
hoc & nwéc ta?

A. Pha rimg 1am nuong ray. B. Khai thac gé qua mic.

C. Sy 6 nhiém méi trudng. D. Tich cuc trong rung.
Ciu 10. Loai nao sau diy cé co quan di chuyén phan héa thanh 2 déi chan
bo va 1 doi chan nhay?

A. Nhén B. T6m song. C. Chau chau. D.
Chudn chuon.
Céu 11. Loai ndo sau day #n thit song?

A. Lon ring. B. Kén kén. C. Té giéc. D.
Cho soi.
Cau 12: Bong vat nao dudi day khong c6 rang nanh?
A. Béo B. Tho C. Chuét chii D.
Khi

Ciu 13. Trong cac nguyén nhan sau, diu 12 nguyén nhan din téi su diét vong
ciia nhiéu loai déng thuc vat hién nay?

A. Kha nang thich nghi cua sinh vat bi suy giam.

B. Xuat hién céc loai dich bénh bat thuong.

C. Cac loali thién tai xay ra.

D. Céac hoat dong cta con nguoi.
Céu 14. Méo, bao c6 dic diém di lai rat ém va nhe béi vi

A. cac ngén chéan co 1éng bao phu. B. dudi cac ngon chan co
dém thit day.

C. dudi cac chan cé 16p da day. D. cac ngdén chan cé vubt
Sac.
Cau 15. bong vat nao dudi day dé con?

A. Thé hoang. B. Thi mo vit. C. Rua. D. ba
diéu.
Cau 16. Sw da dang sinh hoc dwoc biéu hién ¢

A. s6 luong cé thé duc. B. s6 lugng loai.

C. s lugng ca thé céi. D. s6 lugng cé thé duc va

cai.



Ciu 17. Loai dong VAt nao sau day phat trién truc tiép khong c6 nhau thai?

~ A Chimbé céu. B. Cao cio. C. Doi qua. D.
Ech dong.
Cau 18. Loai dong vat nao sau day hoat dong vao ban ngay?

A. Chim cu lon. B. Ngua hoang. C. Doi qua. D.
Tho hoang.

Céu 19. Pic diém nao sau day chi c6 & Thi méng guéc?
A. Chan yéu co tu thé bam vao canh cdy treo ngugc co the.
B. Co thé hinh thoi, ¢6 ngan, c6 16p ma dudi da day
C. Sb luong ngdn chan tiéu giam, dot cudi cia mdi ngdn co sing bao boc.
D. Tt chi thich nghi vé&i su cam nam va leo tréo cay.
Ciau 20. Loai nao sau day c6 co quan di chuyén phan héa thanh 5 ddi chan
bo va 5 d6i chan boi?
A. Nhén B. T6m song. C. Chau chau. D.
Chudn chuon.

Céiu 21: Pién tir thich hop vao chd trong dé hoan thién nghia ciu sau:
Hinh thtrc sinh san ...(1)... khong c6 su két hop gitia t€ bao sinh duc duc voi té
bao sinh duc cai trong su ...(2)... cua tring, ngugc han véi hinh thirc sinh san

..(3)....
A. (1): v0 tinh; (2): sinh san, (3): hitu tinh

B. (1): vO tinh; (2): thu tinh; (3): hitu tinh

C. (1): hitu tinh; (2): phét trién; (3): vo tinh

D. (1): hitu tinh; (2): sinh san; (3): hiru ti nh
Cau 22: Dong vat nao dudi day thu tinh ngoai?

A. Cachép. B. Chim bd ciu. C. Rua nii vang. D.
Tho hoang.

Céu 23: Phat biéu nao dwéi diy Ia ding khi néi vé ludng cw c0?
A. Con di tich cua ndp mang. B. Khong c6 vay.
C. Co vay lung rat phat trién. D. Vay dudi bién thanh
chi sau.

Cau 24: Djc diém nao dudi diy la dic diém cia b Linh truéng?
A. Co6 ngdn chan gitra phat trién hon ca.
B. Chan cao, sb ngon chan chan, dau ngdn chan cé hop strng bao ve.
C. An tap, ban chan ban tay c6 5 ngén, ngon cai dbi dién véi 4 ngén con
lai.
D. Chén c6 5 ngoén, gudc nho, co voi.
Céu 25: Trong cac 16p dong vit sau, 16p nao kém tién héa nhat?
A. Lop Bo sat. B. L6p Ludng cu. C. Lép Giap xac. D.
Lép Thu



PHONG GIAO DUC QUAN LONG BIEN CONG HOA XA HOI CHU NGHIA VIET NAM
TRUONG THCS THANH AM Ddc lap - Tw do - Hanh phiic

PE CUONG ON TAP HQC KI 11
MON: TIN HQC LOP 7
Nim hec: 2021-2022
I. TRAC NGHIEM
Khoanh tron vao chi cdi in hoa dirng trwdc cau trd loi ditng twong g véi cac cau hai:
Cau 1. Mé dai lénh View = chon I¢nh Page Break Preview dé

A. xem ngat trang B. Xem trugc trang in C. in trang tinh D. thiét dat 1& in
Cau 2: Pé thuc hién viée in vin ban vao File va chon
A. Print B. New C. Open D. Share

Cau 3. bé chon hudéng giz‘iy ding ta nhay lra chon nao dwéi day?

A. Land scape B. Portrait C. Horizontally D. Vertically
Cau 4. Trong 6 Al c6 ndi dung “ Bang diém Iép 7N”. Pé ciin chinh ndi dung nay vao giira
bang diém (Giira cac cot tir A dén G). Sau khi chen c4c 6 tir A1 dén G1, em chen nat 1énh?

A= B. = c.== D.=

Cau 5. Pé thay ddi font chir trang tinh ta nuat 1énh nao dwéi day ?

A i v 5. A A cC m - B D Times New Rom =
Cau 6: Nut Iénh Sort Descending ding dé

A. sap xép tang dan B. sdp xép giam dan

C. tang chir sO thap phén D. giam chir s6 thap phan

Cau 7: Pé dit hwdng gidy in cho mét trang bang tinh ta phai thuc hién

A. File ->Page Setup -> Page B. PageLayout ->Page Setup -> Margins
C. File ->Page Setup -> Margins D. PageLayout -> Margins

Cau 8: Mudn dit & phdi caa bang tinh ta chon

A.Top B. Bottom C. Left D. Right
Cau 9: Cach nao trong cac cich sau dung dé in trang tinh?

A.Ctrl +P B. Shift + P

C. Alt+P D. Enter + S

Cau 10: Nhay nut Iénh nao dé sap xép theo thir ty ting dan?

A &b B. 2l

c. = pD. 7/

Cau 11: Pé loc dir ligu ta sir dung Iénh nao?

A. Data -> Sort B. Data -> Filter

C. File -> Filter D. Insert -> Filter

Cau 12: Hop thoai Page Setup dung dé ‘

A. Xem trang trudC B. canh I€ cho van ban
C. thay d6i huong giay D. thiet dat 1€ va hudng giay

Cau 13: Khi vé biéu dé, chwong trinh bang tinh ngam dinh mién dir li¢u dé tao biéu dd 1a
gi?



A. Hang dau tién caa bang sb liéu B. Cot dau tién caa bang sé liéu
C. Toan bo dix liéu D. Phai chon truéc mién dit liéu, khong co
ngam dinh

Cau 14: Pé mo ta ti 1¢ caa gia tri dir liéu so véi tong thé nguoi ta thwong ding dang biéu
dé nao?

A. Biéu db cot B. Biéu db duong gap khuc

C. Biéu db hinh tron D. Biéu d6 mién

Céau 15: Pé thém hoic 4n tiéu dé cho biéu do, ta chon

A. Chart Title B. Axis Titles

C. Legend D. Data Lables

Cau 16: Pé thém thong tin giai thich biéu dd, ta sir dung céc Iénh trong nhém nao?
A. Design / Change Chart Type B. Design / Move Chart

C. Layout / Labels D. Layout / Change Chart Type
Cau 17: Pé x6a biéu do da tao, ta thuc hién

A. chon viing dir liéu nhan phim Delete B. nhay chut trén biéu d6 va nhan phim
Delete

C. nhay chugt trén biéu d6 va nhan phim Insert ~ D. nhay chugt trén biéu d6 va nhan phim
Layout

CAu 18: Muén thay doi kiéu biéu @6 da dwoc tao ra, em cé thé

A. phai x06a biéu do cii va thuc hién lai cac thao tac tao biéu db

B. nhay nat (Change Chart Type) trong nhém Type trén dai Iénh Design va chon kiéu thich
hop

C. nhay n(t (Chart Winzard) trén thanh cong cu biéu do va chon kiéu thich hop

D. khong thay d6i duoc kiéu biéu do da tao

Cau 19. Phéat biéu nao sau day la sai?

A. Biéu db cot khong thich hop dé so sanh dir liéu c6 trong nhiéu cot.

B. Biéu d6 duong gap khiic dung dé so sanh dix liéu va du doan xu thé ting hay giam cua dir
liéu.

C. Biéu db hinh tron thich hop dé md ta ti Ié cua gia tri di liéu so véi tong thé.

D. Biéu db cot thich hop dé so sanh dit liéu cd trong nhiéu cot.

Cau 20: Trinh bay dir liéu bing biéu dé nham

A. rat gon dir liéu

B. dé so sanh, dy doan xu thé tang giam dit liéu, truc quan sinh dong

C. dep 16i cudn nguoi tiép xuc

D. trinh bay van ban ngan gon dep hon

Cau 21: C6 may loai biéu dd thwong dung?
A.2 B.3

C.4 D.5

Cau 22 : Pé tao biéu dé ta chen ving dir liéu va vao



A. Intsert/ Chart B. Home/ Chart

C. Layout/ Chart D. File/ Chart

Céau 23: Cau nao sau day diang?

A. Sap xép dit liéu 1 hoan dbi vi tri cua cac hang véi nhau.

B. Sap xép dir liéu 1a hoan doi vi tri cua cac cot véi nhau.

C. Sip xép dit liéu 1a chi chon va hién thi nhitng hang thoa mén cac tiéu chuan nhat dinh nao
do.

D. Sap xép dix liéu 1a chi chon va hién thi nhitng cot thoa man céc tiéu chuan nhat dinh nao do.
Cau 24 : Nt 1énh dung dé siap xép giam dan?

A. i B. 31 C. il D. ﬁl

Cau 25: Tiéu chuan lgc Top 10 la tiéu chuan lec o

A. hang c0 gia tri cao nhat ’ ) B. hang co gia tri thap nhat ) )
C. cot c0 gia tri cao nhat hoac thap nhat D. hang c0 gia tri cao nhat hoac thap nhat.

CAu 26: NGt 1énh Sort Ascending diing dé

A. sip xép ting dan B. sdp xép giam dan

C. tang chit so 'ghép phé}n D. giam chir so thap phan

Cau 27: be hien thi tat ca cac ban ghi sau khi lgc ta tich chugt chon

A. Select All B. Advanced Filter

C. Show All D. Auto Filter

Cau 28: Pé loc cac hang co gid tri 16n nhat hoic nhé nhét ta sir dung tuy chen nao?
A. Number Filter B. Auto Filter

C. Sort & Filter D. Select All

II. TU LUAN

Cau 1: Muc dich ciia viéc xem trang tinh trudc khi in 13 gi? Néu céac thao tac dé in trang tinh.
Cau 2: Sap xép dir liéu 1a gi? Dé sip xép danh sach dit liéu em c6 thé sir dung lénh gi trong
Excel?

Cau 3: Loc dit liéu 1a gi? Hay néu cac budc can thuc hién khi loc dir liéu.

Cau 4: Biéu db 1a gi? Cac dang biéu d6 thuong gap ? Néu cac budc can thuc hién dé tao biéu

d6 tir mot bang dir lieu?



TRUONG THCS THANH AM PE CUONG ON TAP HQC Kl II
Mon: Vatly 7
) Nam hoc 2021-2022
| LV thuyet
1. Sy nhiém dién do co xat.
2. Hai, loai dién t|’ch.,
3. Chat dan dién- chat cach dién.
4. Cac tac dung cua dong dién. ’ o
5. Cuong do dong dién, hiéu dién thé cua mach noi tiep, song song.
6. An toan di¢n
Il. Bai ta
A. Tw luan
Bai 1. Cho mach dién c6 so dd nhu hinh sau.
Khi cong tic K dong, von ké V ¢6 sb chi U = 5,8V, von ké V1 ¢6 chi
s6 Up = 2,8V.
a. Tinh cuong do dong di¢n I1, |2 twvong ing chay qua cac bong dén
D1 va P2 biét cudong do dong dién chay qua mach chinh 1a I= 2,5A.
b. Tinh hiéu dién thé U giira hai dau bong dén ..
c. Néu dén 1 bi hong, dén 2 sang hay t6i? Vi sao?
Bai 2. Cho mach dién nhu hinh vé

Biét hicu di¢n thé gitta hai dau dén 1 13 12V, cuong do — ]
dong dién chay trong mach chinh va qua dén 2 lan luot

12 0,5A va 0,1A. y ! .
a. Tinh hiéu dién thé gitra hai dau dén 2.

b. Tinh cuong d¢ dong dién chay qua dén 1 < b,

c. Néu dén 1 bj hong, dén 2 sang hay tdi? Vi sao? S

Bai 3. Cho cac dung cu sau: 2 bong dén (P1 va b2), 1

ampe ké, 1 von ké, 1 nguon dién 2 pin mac néi tiép, 1 khoa K, day dan.

a) V& mach dién sao cho 2 dén mac ndi tiép, ampe ké do cudng d6 cua dong dién cua

ca mach, von ké do hiéu dién thé cua dén 1.
b) Biét ampe ké chi 0,5 A; von ké chi 6V; ngudn dién c6 hiéu dién thé 9V. Hay tinh
cudng do dong dién chay qua ting dén, hiéu dién thé cua deén 22
Bai 4. Cho céc dung cy sau: 2 bong den (P1 va D2), 2 ampe ké (A1 va Az), 1 von ké, 1
ngudn dién 2 pin méc nbi tiép, 1 khoa K, day dan.

a) V& mach dién sao cho 2 dén mac song song, ampe ké A; do cudong do cia dong dién
chay qua dén 1, ampe ké Az do cudng do cua dong dién chay qua dén 2, von ké do
higu dién thé clia dén 1
b) Biét ampe ké A1 chi 0,5 A, ampe ké Az chi 0,2 A; von ké chi 6V. Hay tinh cuong do
dong dién chay trong mach chinh, hiéu dién thé caa nguon?

B. Tric nghiém

Céu 1: Vit liéu nao sau diy la chit din dién?
A. Go B. Thuy tinh C. Nhua D. Kim loai

CAu 2: Vit liéu nao sau day la chat cach dién?



A. G6 khd B. Pong C. Sat D. Nhém

Céu 3: Trong kim loai, cac electron ty do 1a

A. cac electron thoat ra khoi kim loai va chuyén dong tu do

B. cac electron thoét ra khoi nguyén tir kim loai va chuyén dong tu do trong toan khoi
kim loai

C. céc electron chuyén dong tu do trong nguyén tir kim loai

D. cac hat nhan chuyén dong tu do

Céu 4: Trong mjt doan day dién, phin nao cia day la chit din dién?

A. Phan vo nhya cua day C. Phan cubi cta doan day

B. Phan dau cia doan day D. Phan 16i cta day

CAu 5: Hién nay, trong cAc thiét bi dién dung trong gia dinh, chét cach dién dwoc
dung nhiéu nhét 1 loai vét liéu nao?

A.Gd B. Su C. Nhya D. Cao su

Cau 6: Quy wéc nao sau day la ding vé chiéu dong dién?

A. Chiéu dong dién la chiéu di tr cyc 4m cua nguén dién qua vat dan t6i cuc duong
ctia ngudn dién

B. Chiéu dong dién 1a chiéu di tir cuc dwong ctia ngudn qua vat din t6i cuc am cua
ngudn dién

C. Cuc duong ctia ngudn dién 12 cuc xut phat cta cac electron khi mic ngudn véi dung
cu tiéu thu dién thanh mach kin

D. Cuc am cua nguén dién 1a cuc dén cua céc electron khi mac nguén vo1 dung cu tiéu
thu dién thanh mach kin

CAau 7: Mt qua cau A cé dién tich dwong, qua ciu B trung hoa vé dién. Khi dwa
hai qua ciu lai gan nhau thi

A. chung day nhau C. khong hut ciing khong day nhau
B. chling hit nhau D. vira hat vira day nhau

Cau 8: Khi cg xat thanh thiy tinh vao lua thi

A. thanh thiiy tinh mat bét electron C. thanh thuy tinh nhiém dién 4m
B. thanh thuy tinh nhan thém electron D. lua nhiém dién duong

Cau 9: Pua tay hai vat di bi nhiém dién lai gan nhau thi chiing

A. ludn hat nhau C. khong hut va khong diy nhau
B. lu6n diy nhau D. ¢6 thé hut hodc ddy nhau

Cau 10: Bong dén tron trong gia dinh phat sang 1a do tic dung nao ciia dong dién?
A. Tac dung nhiét

B. Téac dung phéat sang

C. Vura tac dung nhiét, vira tac dung phat sang

D. Téac dung hoéa hoc

CAu 11: Sip xép theo thit tw cac chat ¢é nhiét dd néng chay ting dan?

A. Vonfram, thép, déng, chi C. Chi, thép, déng, vonfram

B. Chi, déng, thép, vonfram D. Thép, déng, chi, vonfram



Céu 12: Thiét bi dién nao sau diy hoat dong KHONG dwa trén tic dung nhiét ciia
dong dién?

A. Bép dién C. Nbi com dién

B. Ban ui D. Quat may

CAu 13: Téc dung nhiét ciia dong dién trong thiét bi nao sau day la ¢6 ich?

A. Ban la dién C. Quat dién

B. Tivi D. Bong den day toc

CAu 14: Téac dung héa hoc ciia dong dién trong thiét bi nao sau day 1a c6 ich?
A. Tivi B. B¢ ma dién C. Cau chi D. Pau DVD

Cau 15: Ciu chi c6 tac dung gi trong mach dién ¢ nha?
A. Ngét mach dién khi c6 su ¢b chip dién C. Bdo v¢ an toan cho cac thiét bi dién

B. Trang tri cho dep cac bang dién D. Cau A va C ding

Cau 16: Hiéu dién thé dwoc do biang dung cu gi?

A. Ampe ké B. Von ké C. bién ké D. Ap ké
Cau 17: Pon vi do hiéu dién thé la gi?

A.Jun B. Ampe C. Vvon D. Niu —ton

CAu 18: Giira hai 16 ciia 6 dién lay trong mang dién gia dinh & Viét Nam, gia tri
hiéu dién thé 1a bao nhiéu?

A. 200V B.220V C. 240V D.90V

Cau 19: Mudn do cuwdng do dong dién qua mot dung cu dién ta phai

A. mic ampe ké song song voi dung cu dién can do

B. mac ampe ké ndi tiép v6i1 dung cu dién can do

C. mic von ké song song véi dung cu dién can do

D. mic von ké ndi tiép v6i1 dung cu dién can do

Cau 20: Ampe ké 1a dung cu dung dé do

A. tac dung ctua dong dién C. cuong do dong di¢n

B. mac do ctuia dong dién D. kha nang cua dong dién

Cau 21: Pé do cwong do dong dién 15 mA, nén chon Ampe ké nio cé giéi han do
phit hop nhat?

A.2mA B. 20 mA C. 200 mA D.2A

CAu 22: Dong chuyén doi theo mot chiéu xac dinh ciia cic hat mang dién tich goi la
A. dong dién C. dong dién mot chiéu

B. dong dién khong doi D. dong dién xoay chiéu

Cau 23: Dong dién dwoc cung cap béi pin hay dc — qui 1a

A. dong dién khong dbi C. dong dién xoay chiéu

B. dong dién mot chiéu D. dong dién bién thién

Céau 24: Dong dién chay trong mang dién gia dinh la
A. dong dién khong ddi C. dong dién xoay chiéu
B. dong dién mot chiéu D. dong dién bién thién



CAu 25: Muén do hiéu dién thé giira hai diu mét dung cu dién ta phai

A. mic ampe ké song song voi dung cu dién can do

B. mac ampe ké ndi tiép v6i1 dung cu dién can do

C. mic von ké song song véi dung cu dién can do

D. mic von ké ndi tiép v61 dung cu dién can do

CAu 26: Dién tir thich hop vao chd trong: Ngudn dién tao ra giira hai cuc ciia né

11111 PN

A. dién thé C. cuong do dién thé
B. hi¢u dién thé D. cudng do dong dién
Céau 27: Chon ciu sai

A. 1V = 1000mV C.1mV = 0,001V

B. 1kV = 1000mV D. 1000V = 1kV

Cau 28: Pién tir thich hop vao chd trong
Trén von ké, & cac chdt noi diy cé ki hiéu dau (+) va dau (-). Dau (+) phai dwoc

noi VOi....oouvenennn. ciia nguon, dau (-) phdi noi vdéi........... ciia nguon
A. cuc am, cuc duong C. cuc duong, cuc am
B. cuc am, cuc am D. cuc duong, cuc duong

Cau 29: Poi véi pin tron thuong sir dung trong cac dong ho treo twdng trong nha,
gia tri hiéu dién thé giira hai cuec 1a

A 15V B.30V C.60V D.90V

Cau 30: Muon do hiéu dién thé giira hai diu 6 cim dién trong nha, ta phai chinh
thang do trén von ké cé giéi han do

A. dién mot chiéu (DC), GHP bang 220 V

B. dién xoay chiéu (AC), GHP nhé hon 220 V

C. dién mot chiéu (DC), GHD 16n hon 220 V

D. dién xoay chiéu (AC), GHD 16n hon 220 V

Cau 31: Pon vi do hiéu dién thé la gi?

A.Jun B. Ampe C. Von D. Niu —ton
Céu 32: Viéc lam nao sau diy la an toan khi sir dung dién?
A. Phoi quan ao trén day dién. )
B. Sura chira dién khi chwa keo cau dao ngit dién.

C. Choi tha di€u gan duong day dién.
D. Lam thi nghiém v&i ngudn dién 1a pin.

Céu 33: Khi day dién bi hé, cach nao sau day sé giir an toan di¢n?
A. Dung bang dinh cach dién quan lai.

B. Dung ti nilon boc lai.

C. Dung vai kho boc lai.

D. Dun vai udt boc lai.

Céu 34: Trén bong den c6 ghi 12 V. Bong den s€ sang binh thwong khi sir dung &

hiéu dién the bao nhiéu?
A. 220 V. B.24 V. C.12 V. D. 200 V.



Céu 35: Truong hop nao KHONG vi pham quy tic an toan dién?
A. Cim nam bang tay khong mot soi dy dién dang c6 dong dién chay qua.
B. Leo tréo cac cot dién cao thé.

C. Xay nha dudi cac dudng day dién cao thé.
D. bi dép nhya, dung kim dién c6 tay cam bang cao su cach dién tdt khi stra dién.
CAu 36: Trong chiéc ciu chi, bd phin nao 1a vat din dién?

A. Day chi, vo su. C. Day chi, vo su, hai 14 dong.
B. Vo st hai 14 dong. D. Day chi, hai 1a dong

Cau 37: Dé do cwong dd dong dién cé gia tri khoang 1,5 mA, chon ampe ké c6 gii
han do nao sau day la phu hop nhit?
A. 2 mA. B. 20 mA. C.2A. D. 200 mA.

Cau 38: Cho mach dién gobm: 1 ngudn dién, 1 khoa K dong, 2 dén D1, P> mic ndi

tiép nhau. Biét cwong d¢ dong dién chay qua dén D 12 I =3 A. Héi cuwong dd
dong dién qua dén D1 la bao nhiéu?

A.45A. B.3A. C.15A D.5A.
Cau 39: Trong cac chat duéi diy, diu la chat dén dién?
A. GO kho. B. Kim loai. C. Thuy tinh. D. Nhya.

Céu 40: Cong thirc nao dwoi day la ding khi tinh cuong d¢ dong di¢n chay trong
mach chinh ciia doan mach gom 2 dén mic ndi tiép

A l=lh+1 B.l=l1—-1,
C.l=l1:1 D.l=1lh.1



PHONG GD & PT QUAN LONG BIEN PE CUONG ON TAP GITUAKI 11
TRUONG THCS THANH AM Mén : Mi Thuat 7
NAM HOQC 2021- 2022

. Noi dung bai hoc
- Vé trang tri: Chir trang tri
- V& Tinh vat: cai &m tich va cac bat
II.  Yéu ciu can dat
HS duoc cing cb vé cac kién thirc: v& tranh trang tri va tinh vat
I1l. Huwéng din 6n tap
1. Li thuyét
- Thé nao 1a v& tinh vat ?
- Céc budc chir trong trang tri?
2. Thuc hanh
- V@ tranh tinh vat:
+ Hinh thte: bai v& gidng mau
+ Bb cuc: hop li
+ Hinh vé: vé dung hinh
+ Mau sac: danh nén rd sang toi
+ C6 tinh thAm mi
- V& chit trang tri:
+ Hinh thurc: trang tri chit theo tén
+ Bb cuc: hop li
+ Hinh vé: v€ dep, c0 trang tri
+ Mau sic: tuoi sang
+ C6 tinh tham mi
3. Yéu cau thuc hanh
Thuc hanh trén kho gidy A4




TRUONG THCS THANH AM PE CUONG ON CUOI Kl 11
Niim hoc 2021 - 2022 Mon: Am nhac 7

1. On tap bai hét

- Bai hat; Di cat l0a.
- Bai hat; Khic ca bon mua.
- Bai hat Cachiusa.
- Bai hét: Tiéng ve goi hé.

I1. On tap: tap doc nhac
- TDN s6 6.
-TPNs6 7.
- TDN s6 8.
- TDN s6 9.



TRUONG THCS THANH AM
NAM HQC 2021- 2022

NQI DUNG ON TAP CUOI HQOC KI II
Mén: Thé duc
LOP 7

I. Noi dung On tap.
Pa cau: Chuyén cau bang mu ban chan
Phét cau thap chan chinh dién bang mu ban chan
I1. Yéu cau.
Hoc sinh biét cach thuc hién ky thuat:
- Chuyén cau bang mu ban chan

- Phét cau thap chan chinh dién biang mu ban chan

Ban giam hiéu
(Ki duyét)

Lé Thi Ngoc Anh



